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Alkusanat

Ohjeistus koskee erilaisia toimintatapoja 3d Studio Max
ohjelmassa. Ohjeistukset perustuvat toimimiseen ohjelman
versioilla 2009 ja 2011. Kdyn kuitenkin ohjeistuksessa lapi
ainoastaan perustoimintoja jotka ovat ne olleet mukana
ohjelmassa jo edeltavissakin versioissa. Tasta syysta ohjelman

versiolla ei ole suurta merkitysta.

Seuraavilla sivuilla on esiteltyna tutoriaalinomaisesti
tyoskentelytapojani joita kaytin luodessani paattotyota. Niita
lukiesssasi ja harjoitellessasi tulee sinun huomioida, etta itse olen
oppinut tydskentelytapani hyvin pitkalti itse. Tasta syysta osa
toteutustavoista saattaa olla alan kirjoissa opetetun vastaisia tai

asioille saattaa olle helpompikin toteutustapa.

Sinun kannattaa myos huomioida, etta ensimmaisissa
ohjeistuksissa pyrin selittamaan yksinkertaisimmatkin toiminnot,
loppua kohti kuitenkin vahennan perusteiden selittamista. Toisin
sanoen jalkimmainen luku useimmiten olettaa sinun osaavan

edeltavassa opetetut asiat.

Ohjeistukset kasittelevat padasaantoisesti 3d-grafiikan
toteuttamisen perusteita, mutta sinulla olisi kuitenkin hyva
olla etukateen jonkin verran tietoa ohjelmasta. Esimerkiksi

perusobjektien luomiseen ei tassa ohjeistuksessa paneuduta.

Mallintamisen iloa

Arto Rantakoski



1.1 NURBS-tydkaluilla mallintaminen (Kadun luominen): keskivaikea
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T#aemt 4 Valitse luotu surface tai mikali se on

1. Luodaan tasainen pinta valitsemalla oikean reunan tyokalulaatikosta Create
-> Geometry -> NURBS Surfaces -> CV Surf. Piirretaan nelio ylanakymasta ja
asetetaan sen leveys- ja korkeusarvoiksi taman jalkeen 800 x 800 ja molempiin
CV’s arvoihin 15.
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2. Luodaan katujen muoto e

valitsemalla Create -> Shapes
->NURBS Curves -> CV Curve.
Curvella piirtdaminen voi vaatia
pienta harjoitusta, joten voit
pariin kertaan leikkia tyokalulla,
tuhota tekeleesi painamalla
Delete ndppdimistosta ja vasta
taman jalkeen yrittaa lopullista
muotoa. Kuvion tulee mahtua
piirretyn nelion sisaan ja olla
suljettu (alkaa ja paattya samaan).

3. Valitse luotu surface (nelid) ja taman
jalkeen Modify ->[E8-> Surface CV ->
Single CV.Tama jalkeen valitse
yksittdisia pisteita surfacesta riveittain
ja luo pintaan maki Left viewportista
katsottuna. Surfacen tulisi asettua
molemmin puolin piirrettya CV Curvea.

TP B edelleen valittuna edellisen askeleen jalkeen .
nouse takaisin ylemmalle tasolle klikkaamalla 5..l.\IURBSe|IIa o
- NURBS Surface. Taman jalkeen valitse Attach tyoskennellessa pitdisi

ja klikkaa piirrettya CV Curvea (Piirretty tie
=~ sl2 kuvio). Nain molemmat kuviot yhdistyvat.
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. sinulla olla ndkyvissa
erityiset NURBS -tydkalut
omana laatikkonaan, mikali
ndin ei kuitenkaan ole 16ytyy
askeisen Attach- nappulan
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Gloe oo s i & jalkeen valitse laatikosta Create Vector
S Projected Curve ja klikkaa ensin luotua
e | | i — Curvea ja sitten Surfacea. Taman jalkeen
e DIl e e winlvelm oikeassa reunassa tulisi ndkya Trim Controls
. — Taﬁ ro 7, -valinnat. Joista raksit Trim -kohdan. Mikali
- o L L . et e lopputulos ei ole kuvan mukainen vaan
6. Tarkista, ettd objekti on valittuna ja [ — @J vazfainen valitse Flip Trim
paina nappadimistosta Ctrl + v. Clone S Vet T3 ' P '
Options -valikon pitdisi ilmestyd ndytolle. o
.o .. e . . . ¥ Tiim
Taman jalkeen valitse Copy ja klikkaa OK. 7 Valikko ei valttamatts ole

Siirrd luotua kloonia aavistuksen verran

alaspdin. Ja siirry valikossa seuraavasti Modify ->[a

-> Curve. Taman jalkeen valitse klikkaamalla kloonatusta
elementista sita leikkaava curve ja rullaa oikean reunan
valikkoa alas kohtaan Vector Projected Curve.

kokonaan nakyvissa, mutta
klikkaa otsikon vieressa olevaa "+”
saadaksesi sen nakyviin.

Nyt vaihda Flip Trim -valinta
painvastaiseksi, jolloin ndkyva ja
poisleikattu osa vaihtavat osia.
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8. Palaa objectissa NURBS Surface -tasolle klikkaamalla
sitd, valitse Attach ja yhdista kloonattu elementi yhdeksi
alkuperdisen kanssa samalla tavoin kuin kohdassa 4.
Taman jalkeen valitse Create U Loft Surface NURBS-
tyoOkaluista ja klikkaa vuoron peradan molempia surfacea
leikkaavia curveja. Ndin ylemman ja alemman pinnan
valiin pitdisi syntya yhdistava pinta. Mikali pinta nakyy
mustana tai ei ndy ollenkaan, valitse Flip Normals oikean
reunan valikosta.

Lopputuloksena pitdisi syntya katutaso taloille.



1.2 NURBS-ty6kaluilla mallintaminen (Porttikongin ylakaari): helppo

T — AT D mE 1. Jos edellinen epdonnistui tdssa hiveen helpompi 2. Kopioi kaari painamalla
,1__[!5“9@ T T T tehtava. Jos taas onnistui, voi tehtavan ottaa Ctrl + % tarki§ta e:‘tté Copy
Qg2 emT | kertauksen kannalta. on valittuna ja klikkaa
= OK.
Klikataan ylareunasta paalle Snaps Toggle, jolloin Taman jalkeen klikkaa
kursori hakeutuu apuviivojen risteyskohtiin. Taman Snaps Toggle pois paalta,
helpottaa tydskentelya kyseisessa tehtavassa. silla se saattaa hairita
Luodaan kaari valitsemalla Create -> Shapes -> skaalauksessa.
NURBS Curves -> CV Curve. Curvella piirtaminen voi
vaatia pienta harjoitusta, joten voit pariin kertaan
7 Adie leikkia tyokalulla, tuhota tekeleesi painamalla e e
St | | 'Delete’ nappaimistosta ja vasta taman jalkeen yrittaa & Comy @ Oy
T = i
© vt lopullista muotoa. Kaaren ei my6skaan ole pakko : 'F:“:f:; Millieses
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vastaavan kaaren klikkaile kuvassa olevien vihreiden [Furveid
\p,HHH\HA)JHHIH\)P\IHHIHBJpHI\HHklg\pH\HHH]éﬂ pISteIden kaUtta. Ok J Cﬁnmﬁ |

(i )

3. Valitse Select and Uniform
Scale ja skaalaa kopioitu kaari
pienemmaksi niin, etta se jaa
alareunassa alkuperaisesta
kaaresta kahden ruudun paahan.

4. Klikkaa Snaps Toggle takaisin
paalle, valitse isompi kaari ja
kopioi jalleen ctrl+v ndppain
yhdistelmalla. Siirrd nyt kopioitu
kaari kaksi ruutua eteenpain.

S 5. Luodaan jalleen uusi 6. Valitse joku jo olemassa olevista

W@ & eE T . R .
kaari valitsemalla Create -> ILI kaarista ja klikkaa Modify ja alle
Shapes -> NURBS Curves -> | aukeavasta valikosta Attach.
CV Curve. Kaari piirretaan Taman jalkeen klikkaile lapi kaikki
mutkittelemaan ulomman piirtamasi kaaret. Nyt kaikki
kaaren alareunasta pikkukaaren w w0 s i | ovat yhtd ja samaa objektia.
alareunaan. Mikali kaaret === | Seuraavaksi siirrymme kdyttamaan
alkavat keskipoikkiviivalta, e ”mew NURBS tooleja, joten jos et

nde erillista laatikkoa, jossa on
vihreitd symboleja, klikkaa NURBS
Creation Toolbox, Attach nappulan
alapuolella.

tulisi uuden kaaren sijoittua
automaattisesti oikein ylhaalta
pain piirrettaessa. Kaaret
piirretaan kuvan mukaisesti
molempiin pdihin.

7. Laatikosta valitaan
Create U Loft Surface ja
taman jalkeen klikataan
perdkkdin molempia

isoja kaaria. Kaarien vliin
pitdisi syntya pinta. Mikali
pinta kuitenkin nakyy
ylospdin mustana tai ei
ndy ollenkaan, klikkaa Flip
Normals.
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8. Seuraavaksi samaisesta laatikosta valitaan Create UV Loft Surface, jonka jalkeen klikataan ensin ulkonevaa isoa kaarta hiiren
vasemmalla ja sen jalkeen pienempaa sisakaarta hiiren vasemmalla. Sitten yksittdinen klikkaus hiiren

oikealla ruudulle. Taman jalkeen klikataan hiiren vasemmalla vuorotellen molempia pdissa olevia lyhyita kaaria ja lopuksi viela
klikataan hiiren oikealla ruudulle. Nyt kaarien valiin pitdisi syntya kuvan osoittama pinta. Mikali pinta jalleen kerran nakyy
mustana tai ei ndy ollenkaan, klikaataan Flip Normals.



2.1 Edit Polylla mallintaminen (talon luominen): keskivaikea
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1. Luodaan laatikko valitsemalla Create ->
Geometry -> Stadard Primitives -> Box ja

piirtamalla se ylanakymasta.
annetaan laatikolle kuvan osoittamat arvot.
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2. Asetellaan laatikko ylhdaltapain keskelle ja
sivulta tai edesta pdin katsottuna keskiviivan
alapuolelle.

4. Klikkaa Vertex -valinta paalle Selection -valikosta. Taman jalkeen

voit lilkuutella laatikon muotoa kontrolloivia vertex -pisteita (siniset
pallurat). Vertexeja voi valita joko klikkaamalla, jolloin paallimmaisin
vertex tulee valituksi, (mikali niitd on useampia perdkkain kyseisesta
kuvakulmasta katsottuna) tai painamalla hiiren vasemman nappulan
pohjaan ja vetamalla laatikon, ihan kuin kuvankasittelyohjelman leikkaa
tyokalulla. Talloin kaikki alueen sisadn jadaneet vertexit valitaan (muuttuvat
punaisiksi). Talla tavoin toimien sinun tulisi jarjestaa vertexit ylareunan

kuvan mukaisesti ylhaaltapain katsottuna. Huomaa keskikohdan

leveampi alue.

5.Vaihda Vertex -valinta
Polygon -valinnaksi
klikkaamalla punaista neli6ta.
Taman jalkeen pyodrittele
objekti kolmiulotteisessa
nakymadssa niin, ettd voit
ndhda sen kokonaan. Paina
Ctrl pohjaan ja valitse
yksitellen klikkailemalla
koko laatikon ylapuoli
ohuita reuna-alueita
lukuunottamatta.

6. Rullaa oikean reunan
valikkoa alaspain kunnes
I6ydat Extrude -nappdimen
Edit Polygons kohdan alta. Ala
kuitenkaan klikkaa Extrude-
nappulaa vaan pienta laatikko-
nappulaa tdman vieressa.
Extrude Polygons -valikon
tulisi avautua, aseta Height-
arvoksi 10 ja paina OK. Toista
sama viela kaksi kertaa taman
jalkeen, jolloin pitdisi syntya 3
uutta kerrosta.

7. Klikkaa hiiren oikealla kolmiulotteisen
nakyman ylanurkassa Perspective
-tekstin paalla. Nurkkaan avautuu
pudotusvalikko, jossa klikkaa Edged
Faces. Tall6in Edge:t nakyvat myos
kolmiulotteisessa nakymassd, mika
helpottaa tydskentelya. Valitse jalleen
kerran Ctrl pohjassa polygoneja
(seinamid) kuvan mukaisesti. Taman
jalkeen toista dskeisen kohdan extrude
toiminto, mutta vain kerran ja anna
height arvoksi -2. Olemassa olevaan
parakkiin tulisi syntya oven ja ikkunan
painaumat.



wel&emT 8. Valitaan jalleen 9.Taman jélkeen
,—j kerran koko valitaan ctrl pohjassa
wEem @ kattotasanne ctrl luodun matalan
pohjassa ja kdytetaan kerroksen sivut ympari
Extrudea niin kuin taloa, ei kuitenkaan
aiemminkin. Arvoksi = Il "takaseinin” kohdalta.
~wa | s || annetaan télldkertaa & Taman jalkeen taas
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10. Seina ei kuitenkaan tyonny joka suuntaan haluamallamme
tavalla vaan ainoastaan eteenpain, jolloin joudumme kdymaan
vuoron perdan valitsemassa kuvan osoittamalla tavalla sivulla
olevan polygonin (seindman) ja siirtamadssa sen normaalisti
nuolityokalulla raahaamalla sivullepain.

11. Luodaan uusi kerros taloon. Eli valitaan katto,
lukuun ottamatta reunusta. Extrudea kolme kertaa
arvolla 10 ja tdaman jalkeen kerran arvolla 2. Tehdaan
vield ulkonevat reunukset ylimpaan luotuun tasoon niin
kuin edeltavassa askeleessa ja lopuksi luodaan uuteen
kerrokseen ikkunoiden ja mahdollisten parvekkeiden
ovien syvennykset extrudella kdyttden arvoa 2.

12. Pyorittele taloa
kolmiulotteisessa nakymassa
niin, etta voit ndhda talosta
ulkonevien reunusten paat.
Nama ovat menneet vinoon
extrudea kdytettdessa
palikoiden tyontyessa

ensin eteenpain. Vaihda
Polygon -valitsimesta Vertex
-valitsimeen klikaamalla
valikon pallorykelmdd, samalla
tavoin kuin kohdassa 3. Valitse
ylanakymasta hiiren vasen
nappi pohjassa reunuksen
padssa olevat vertexit ja siirra
ne kulkemaan takaseindn
mukaisesti.




13. Vaihdetaan takaisin Polygon -valitsimeen ja valitaan kattotasanne reunusta
lukuunottamatta ja kdytetaan Extrudea. Arvolla ei tassa tapauksessa ole valia,
kunhan uusi pala nousee selkeasti ylospain edellisesta. Taman jalkeen vaihdetaan
Vertex -valitsimeen ja valitaan kaikki uuden palan takareunuksen vertexit ja
nostetaan niita ylopain niin, etta kattoon saadaan kaltevuutta.
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14. Valitaan samaisen tason kaikki etureunan vertexit ja lasketaan niita ﬁg%
kuvan osoittamalla tavalla alaspain ldhelle alempaa kerrosta, ei kuitenkaan kiinni. e |

Taman jalkene valitaan seka katon etureunuksen vertexit yhden aikaisesti sen
alapuolella olevien vertexien kanssa (kaikki vertexit, jotka jaavat ylapuolella
olevassa kuvassa ympyran sisdan. Taman jalkeen rullataan oikean reunan valikkoa alaspdin kohtaan, jossa Extruden
vieresta 16ytyy Weld. Klikataan laatikkoa Weldin vieressa ja erillinen Weld Vertices -laatikko avautuu. Rukkaa arvoa
yléspdin niin kauan, kunnes kaksi valitsemaasi vertex rivistda yhdentyvat yhdeksi riviksi. Rivi myos siirtyy kohtaan
molempien vertex rivistdjen valissa, joten klikkaa OK hyvaksyaksesi muutoksen ja sulkeaksesi Weld Vertices laatikon ja
siirrd koko rivistd alemmas samalle tasolle ulkoneman yldreunuksen kanssa.

15. Seuraavaksi teemme porttikongin, joten vaihda Polygon -valitsimeen ja pydrittele mallia niin kolmiulotteisessa
nakymadssa, etta naet talon keskelld oleva leveampddn kohtaan, mikali jatit siihen sellaisen. Valitse nyt kuvien mukaisesti
alareunan polygonit ja poista ne painamalla ‘Delete’ nappdimistostasi. Polygonien tulisi nyt havita.
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valikkoa alaspain, kunnes |0ydat Create napin. Paina nappi pohjaan. Tamén
rmie] 1 ||| jalkeen zoomaa kuvan osoittamalla tavalla Iahelle kohtaa josta poistit "kivijalan”.

Klikkaa nyt yksitellen ensimmaisen kuvan osoittamat ympyroidyt vertexit lapi
kiertavassa jarjestyksessa ja vield kertaalleen vertex, josta aloitit. Vertexien valiin
pitdisi muotoutua pinta. Toista sama toiselle reunalle ja lopuksi keskelle.

i Flspest Last |
= Nore |

17. Luodaan sylinteri valitsemalla Create -> Geometry -> Stadard Primitives -> Cylinder. Asettele sylinteri ylapuolella olevan
kuvan tavoin poistetun kivijalan ylapuolelle, niin etta talossa poikittain kulkeva edge (viiva) kulkee sen keskion lavitse. Taman
jalkeen skaalaa sylinteria leveammaksi niin etta se juuri ja juuri yltda molempiin pystysuuntaisiin edgeihin.
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L — valista ja rullataan valikko alaspdin kunnes vastaan
tulee Cut -nappula. Klikataan nappula paalle ja
siirrytddn katsomaan taloa Front -nakymasta.
Viedaan hiiren kursori pysty ja vaaka edgen (viivan)

e risteyskohtaan, jolloin kursori muuttuu. Klikataan

T kohtaan hiiren vasemmalla ja jatketaan klikkailua
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Create: Collapse

Tanen 5] osen 1 sylinterin toisessa laidassa olevaan risteyskohtaan.

e Taman jalkeen klikataan kerran hiiren oikealla

L mihin vain toimenpiteen lopettamiseksi.
Sylinterilla sinéllaan ei ole mitaan tekemista

Weld Vertices koko toimenpiteen kanssa vaan se on vain
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20. Vaihda Polygon -valitsimeen ja valitse kuvan mukaisesti
kaaren alapuolella olevat polygonit. Tydnna kaari Extrudella
sisaan. Pida edelleen taaksepain puskettu seindma valittuna
ja paina 'Delete’ ndppadimistosta puhkaistaksesi kdytavan
"sisdpihalle”.

Valitse vield toisen kuvan mukaan kdytavan alapinnan
polygonit ja poista ne ‘Delete’lla.
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Common Rendarer
Render Elements Fiaylracel ‘ Advanced Lighting

= Select Advanced Lighting. I

N - | ¥ Acve

21. Luo talolle valaistus valitsemalla
Create -> Lights -> Standard ->
Skylight. Klikkaa minne tahansa
neljasta eri nakymasta, jolloin
kohtaan ilmestyy valaisimen
aariviivat. Sijainnilla ei ole
minkaanlaista merkitystd, koska
valaistus Skylight:issa tulee aina
ylhaalta. Siirry Render valikkoon
painamalla ndappaimistosta 'F10’
-nappullaa. Erillinen Render

Scene -valikko aukeaa. Siirry
Advanced Ligting -valilehdelle ja valitse pudotus valikosta Light Tracer. Lopuksi klikkaa Render -nappulaa
alareunassa. Light Tracer ei ole skylight valaistuksen kanssa pakollinen, mutta nopeuttaa prosessia
huomattavasti. Kuvan talolle on myos lisatty ennemmin piirtamamme koristekaari komennolla File ->
Merge -> 'Tiedosto’-> Open -> All -> OK.




2.2 Edit Polylla mallintaminen (rengas): Vaikea

2. Klikataan ylhaalta
Snaps Toggle paalle, ja

siirrytddn muokkaamaan
[ planea valitsemalla
Modify -> Edit Poly.
Taman jdlkeen valitaan
Edge -valitsin.

CIE@EITY 1 | odaan pinta
B ¥ A .

valitsemalla Create ->

Geometry -> Stadard

seswee || Primitives -> Plane.

e me | Piiretadn objekti Front-
kuvakulmasta, annetaan
sille kuvan osoittamat arvot
ja asetellaan se keskilinjan
= oikealle puolelle niin etta
=o 7]l planessa kulkevat edget
w2 || Ovat padllekkain taustan
Widhsegs[T—— 3| e .
g apuviivojen kanssa.

e[ T 3
Demsiy[TD—— =

Ble|ET|

w®Ilwelm

<No Curent Operaion>
Comit
Settings Caneel
I ShowCage  [I[]

iie 2 0BT 4, Vaihda Edge -valitsin

Plarelt Planed! 1]

————— famis - 3. Rullaa oikean e = Polygon -valitsimeen,
Edit Pol 1 © @ EdiPoly . .
2 reunan valikkoa FE™ 7 valitse planesta muutamia

alaspain, kunnes polygoneja kuvan
I6ydat Cut- mukaisesti (Ctrl pohjassa
SR nappulan. Leikkaa klikkausten valilld) ja
B leti!!a Front- rullaa oikean reunan
™8| nakskulmasta valikkoa alaspain kunnes
===l planeen kuvan _ewen || |Oydat Extruden. Klikkaa
emaefies 1| osoittamat o B pienta laatikkoa Extruden
vinoviivat. “wermen 5| Vieressi ja aseta Height

I Pisserve s 0]
Creste | Colispse
Erinude Along Spline || . a -
g Tl arvoksi 4. Lopuksi hyvaksy

T
Refiingulate im .
e B | klikkaamalla OK.

&/ ©|m T|
|

. Local Nomal
© ByFolaon

w8z

Slice Plane |~ Spit

Slice Feset Plans
QuickSlice.

6. Pida edelleen polygonit valittuina ja klikkaa
yldreunasta Selecet And Uniform Scale péélle.
Taman jalkeen scaalaa kuvan mukaisesti
polygonien pintaa hivenen pienemmaksi Front-
nakymassa.

Estrusion Height:
(G -
£ Losal Nomal

£ By Polygon

5. Toista askoinen klikkaamalla laatikkoa
Extruden vieressa uudelleen. Annan
kuitenkin talla kertaa arvoksi vain 1.
Hyvaksy klikkaamalla OK.

ol @ &1/ T|
[Modrertsr ]
y -,

Plane

::‘nf‘@&“@‘@‘?ﬂW 7. Klikkaile jonnekkin tyhjaan, iR ]

e - ettd dskoiset valinnat poistuvat — e

PRI javalitse kuvan mukaisesti =i '
polygonit planesta (Ctrl pohjassa).
Kun Polygonit ovat valittu, paina

'‘Delete’ nappaimistostasi

Cammt

Settigs Cancel

I~ ShowCage =]

ome
T e Stack Selection
I ByVeit=s
I™ Ignore Backfacing
I~ 6y Al [450 =

shink | mrow |

w8l

W Mol ( Animate
2Ha Curent Operations
Cartimit
Setlings Caneel
I ShowCage  [][]

8.Vaihda Polygon -valitsin Vertex-
valitsimeen, ja valitse kuvan osoittamat
vertexit painamalla hiiren vasen nappain
pohjaan ja rajaamalla Front -nakymassa
kuvan osoittamat vertexit valituiksi. Taman
jalkeen siirrd Vertexeja hivenen alemmas.

|
T Use Stack Selection
I ByVeter
I~ Ignore Backtacing
T ByAnge: [150 Ei
Shink Grow
Rirg 2] oos |2
et Stack Selection

Comit

Seilings Cancel
I ShewCage ][]

9.Vaihdetaan Edge -valitsimeen ja valitaan
kuvan mukaisesti kaksi edged, joko
yksitellen tai yhta aikaa ja siirretdan planen
vasempaan reunaan, niin etta kohokuvioiden
vasemmasta reunasta tulee suora.

T Use Stack Selection

T ByVeten

T lgnore Backfacing

I~ By Al [350 =
Shiink Grow
Fing | 2| Lo |2l
Gl Stack Selection




/| 2@ T
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10. Valitaan Polygon -valitsin, klikataan padlle By Angle -asetus ja tarkastetaan
,ettd sen numeerinen arvo on jossain 10 ja 50 valissa. Valitaan kuvan osoittamat
pinnat ja painetana 'Delete’ ndppadintd pintojen poistamiseksi. By Angle -valinta
helpottaa pintojen valitsemista, koska talloin valintaan kaikki samansuuntaiset
toisissaan kiinniolevat polygonit.

© untitled - Project Folder: D:\0HJELMATA3dsMax9\3d
Ele Edt

Kaksd]

5 R NETIE

I Use Stack Sekection
™ ByVetex

lgnore Backfacing
)y Angle: [750 =
 Shiink. Grow

Goup Miews Create Modfiers reactor  Arimati

12. Pidetaan kopioitu
Mirror: Screen Coordi... E”X' objekti valittuna, klikataan

CNEIREE ~Mirorsis.——— | Front -ndkyma aktiiviseksi
®%  C® klikkaamalla nakyma alueelle
clas el ja valitaan ylavalikosta Tools ->
— . ® Mirror.
Coie O ten: - ] | 1. Kopioidaan objekti o[0T 2] Valitaan Mirror Axis kohdasta
- Object- | [ Contaler—— | valitsemalla se painamalla T arvoksi X. Mikali tsma
. . .. sl e :
* Copy & Copy ‘ctrl+v’ Tarkistetaan etta esiin i ei kuitenkaan nayttaisi
£ irsiccs € Imtsnzz || jlmestyvassa Clone Options- ‘s c;;na kaantavan objektia
€ Reference . . . Lopy
. ference paneelissa on Copy valittuna ja £ Instance peilikuvaksi poikittaisessa
;‘me hyvaksytaan klikkaamalla OK. ¢ Reference suunnassa voidaan kokeilla
anel
_ . I Miror IK. Limits muita arvoja. Lopuksi
e Corcsl | ) : hyvaksytaan klikkaamalla OK.
: | owes |

13. Valitaan kopioitu
objekti ja raahataan se
sivuttain Front -ndkymassa
alkuperdisen objektin
vasemmalle puolelle kuvan
mubkaisesti. Molempien
objektien reunojen tulisi
jaada ihan pikkuriikkisen
paallekkain tai erittdin
lahekkain.

w2 @B T
E—

14. Valitaan jompi kumpi
objekteista ja liitetddn
objektit yhdeksi Attach-
komennolla, joka 16ytyy
oikeanpuoleista valikkoa
alaspain rullaamalla.

w78 @

i e

Get Siack Selest

Whols b

i
elects

RepeatLast
Constsitss [None =]
I~ Presene s 0]

Creale. Collapse
Gz ) oo [

15. Liittamisen jalkeen liitetyn objektin pinnat
kuitenkin todennakoisesti pyorahtavat vaarinpain,
joka johtuu peilikuva yhteydesta objektien valilla.

iE| Klikkaa Polygon -valitsin paalle ja valitse kaikki

et Stack Selection . a o

— ermesd [ “tummaksi” muuttuneet polygonit. Rulla oikean
reunan valikkoa alaspdin kunnes Ioydat Flip-
nappulan joka kaantaa pinnat takaisin oikeinpain.

I™ Use Stack Selection

16. Vaihda Vertex -valitsimeen ja valitse
kuvan mukaisesti vertexit lahella
yhtymakohtaa. Rullaa oikeanreunan
valikkoa alas klikkaa pienta laatikkoa
Weld -painikkeen vieressa, Weld

Vi Tt wlfil s = Vertices -paneelin tulisi avautua.

m LT A0 Rukkaa nyt arvoa suuremmaksi,
ore After: 172 — r— - & Stac fion .. . . .
: F syve niin etta vierekkain olevat vertexit

I Ignore Backfscig
2 0 o yhdlstyvgt thek5| ja plr?jca kahden palan valilla yhdl‘styy. Mlk:::\ll
—ee sl 2| arvoa kuitenkin rukkaa liian korkealle alkavat vertexit yhdistyi
Get Stack Selestion . . . . . .
awesed | toisiinsa ei toivotulla tavalla, kuten ylapuolella olevassa pienessa

kuvassa. Hyvaksy lopuksi klikkaamalla OK.

Edtude |0 weld
Chanfer [0 Targettweld
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Planelz

Mordifer List -

17. Palaa takaisin ylimalle tasolle Edit Polyssa
klikkaamalla kuvan osoittamasta nappulasta
valikko pieneksi ja ala kopioida kappaletta

'Ctrl+v" komennolla. Sijoita uusi pala aina entisen
ylapuolelle niin, etta valiin ei jaa tyhjaa tilaa.

Voit my0s kopioida useita kappaleita kerralla
valitsemalla yhden sijasta monta. Jatka tata kunnes
sinulla on 16 palaa paallekkain.

lane.

wlfiilv e lm

V@@l '%\
[Feree 18. Valitse joku paallekkain T
e — Jokup , ] -

olevista paloista ja yhdista W—” lm—_!
loput samaan palaan o
rullaamalla oikeanreunan
valikosta Attach -nappula

o esiin, klikkaamalla toiminto

{10 ) T
_a | || aktiiviseksi ja klikkailemalla

Plane

Weld Threshold:

76 3
Mumber of Vertices:
Before: 10736 Alter: 7709

Apoly oK Concel

w8z

®INM w8 l@m
Shrink. Grow

firg |2 Loop. |2] I S I |
Get Stack Selection

muut objektit lapi vuoron
peraan.

(Giet Stack Selection

‘whole Object Selected

10736 Vertices Selected

Break 1

Fiepeat Last
Constiaiis [Nere <] Exuude J weid (B)
I~ Preservalivs 0 Chanfer M| Targetweid
Cieate | Collopss Comect
A Getach |0 Remoye [solated Vertices
e — Remove Unused Map Verts

19. Klikkaa Vertex -valitsin paalle ja valitse kaikki
lw\f\ﬂx\‘@lm Tr”[\ u\?\«&u@\@m w[#] B e|E T| objektin vertexit yhta aikaa. Rullaa oikeanreunan
= valikosta Weld esiin ja klikkaa pienté laatikkoa

[ Mo Lis ~ Madlfer List -
o Sow tdman vieressa. Tutuksi tullut erillis paneeli aukea,

S ) ja rukkaa lukua kuvan mukaisesti yl6spain. Palojen
OBJECT-SPACE MODIFIE .. . . . . . . ..
yhtymédkohdissa olevien vertexien tulisi yhdistya.

Akiribute Holder
wiiilwalm 834 Colfsions

@ Model Arimate T
<No Curent Operation> T = by [0
. clelcPatel = 5
Conrit B e Ditection 570 2|
Diplace Ui
Seiings Dance] Sl i =
I~ GhowCase (W[ Edit Nomals

ey svrz‘

ol 20. Klikkaa Vertex -valitsin pois paaltd ja Modifier List

T Limit Effect

Edit Palch

rhme | m 5 o —4|  pudotusvalikko nakyviin. Valitse pudotusvalikosta Bend

I™ Ioneie Backfaciig

(T ja aseta kenttiin kuvan osoittamat arvot. Objektin pitdisi
EEET ek nyt kaareutua ympyraksi.
GetStack Selection L
e el
Mesh Select
MeshSmooth v

21. Avaa Modofier List | A A@E| T NV 2 C R M © Untiti=d - Project Folder: D:\OHJELMATA3dshax9\3dsmax - Autodesk 3ds Max 9 -Display ; Direct 3D
ja”een ja Valitse Iistasta [Faete | IP‘E”EUE—"—" Fle Edc Iook Grop Yews Cjeste Modfiers reactor Anmalion GiephEgtors Rendeding Citomie MAUSGrpt ep

- e 7 o T |

FFD(box). Alle avautuu e [ L — o A -
valikko, jossa klikkaa e e M

. Poir Cache SM) [Moarerte <]
Set Number Of Points- el EED-r] e
nappulaa. Ruudulle avautuu |esierseae uaoine L
Set FFD Dimensions- 5 i
paneeli, syota kaikkiin = :

’ Contioke i

.. C - . o i mber o P
kenttiin arvoksi 5 ja klikkaa | s 1 =
OK. Seuraavaksi klikkaa Bits” e ‘

. .s es Edit Normals _ Set Number of Paints
pientda plussaa FFD(box) Ej;ﬁigf““ octrs -

. - . Face E;vnude = UF@J“VDM“E 2 Lattice.
tekstin edessa Modifier i L I S
Listin alla jolloin alavalinnat —— R

- . o Conlinuty [550 5] £ Astioss
avautuvat nakyviin. L rm’i T
Klikkaa Control Points [ =g e T
aktiiviseksi ja valitse — IEIPETE| T nemm  S— : - | e o
Lomw i
E !HWH”i‘ﬂmHHH}!UHHIHHQ%HHHmd‘ﬁ”mHIijlmHs&)‘”HHH;}J”Hmng“‘mms‘ﬂ”mm“m‘n (&\xlmw\mr?\

kgsklllnjalla olevat pisteet o [ o B e e e,
rajaamalla Front -ndkymaa kayttden, samoin kuin I [t e 5050 | [aatime

valitsisit useita vertexeja. Klikkaa Select and Uniform
Scale -tyokalu paalle ja skaalaa Left -ndkymassa keskilinjaa hivenen ulospain pullottavaksi.

Auto Key | Selected |t | 5] vw (oo (O 5
Setkey| [, KeyFlws, | WA[T 4B 5 &




22. Seuraavaksi valitse molemmat reunat eli ensin rajaat toisen reunan sitten ‘Ctrl’ pohjaan ja rajaat toisen reunan. Kun control
pointit on valittu skaalaa niitd sisddanpain Left -ndkymassa ja tdiman jalkeen [dhemmads renkaan keskikohtaa front nakymassa.
Niin etta renkaasta tulee hivenen littedmpi.

i@ BemT

Patchselect ~
PatchDeform =
PathDeforn

Physique

Point Cathe:

Pol Select

Preserve

Projection

ust
fezctor Cloth
reactor SoftBody

Ripple
Select By Channel
Shel

Skew

Skin

Skinorph
Skinlrap
Skin'wrap Patch
Shice

Smooth

Spheriy
Squesze

STL Check

Substiute
SuiDefom
Symmetyy
Taper
Tessalaiz

TuntaMesh

Tumto Patch

Tumnto Paly

Twist

T Unwap v

LV Map v

© Render Scene: Default Scanline Rende. .. |:]IEE|

o | & @@ T|
IW[

FFD(box) 53545
Edit Poly
Bend
EditPoly
lare

@l e lm

uemnmns El
I~ Rendetlters: [T 5|
I lssine Displsy
™ Explicit Nomals

- Suface Parameters
[¥ Smooth Resul
Separate by:
I Moteriale
I Gmoothing Groups

Update: O ptions

’7 & Blwaps
 \hen Rendeiing
 Manuall

el Aelm T

wIN el

[ Paametes ]
Roiius [77200 2
Height:[B03% 2|

Height Segmentss[E 2

CopSevenis [T 2|
Sides:[3 3]

¥ Smooth

I Slieein
Sl Fror [0 3]
SleeTe 00 12

¥ Generate Mapping Coords.

I~ Realword Map Size

Carnrior | Renderer |
Render Elements | Raytracer | |
= Select Advanced Cighting 1

(e | scive

]

23. Klikkaa Modifier List -pudotusvalikko auki ja valitse listasta Turbo
Smooth. Renkaan muotojen tulisi pyoristya samantien, mutta mikali
ndin ei kay, tarkista ettd Iterations kohdan arvo on 1 tai suurempi.
Arvon rukkaaminen huomattavasti suuremmaksi tekee muodosta
entistd pydredmman, mutta ndin toimiessa kannattaa noudatta
pientd varovaisuutta. Silld renkaan rakenne monimutkaistuu ja tulee
raskaammaksi tietokoneella prosessoida.

Q7| &em T
onDao v %
— Obeive
™ AutoGid
Taiget Spot
Target Diect
Oroni

Fiee Spot

i

Fiee Direct

{

i frea Omni| e Area Spot |

e ard Celor
]
- Skylight Parameters
7 On Mulipler: [TT 3]
~3ky Color
€ s Scene Envionment
& Sky Color

W Map: [T000 3|

Hone

i

|

I™ Cast Shadows
Reps per Sample: [20 |
Flay Bias:[0005 3|

24. Luodaan vield renkaan keskelle
sylinterilla vanne ja muokataan sita
oman mieltymyksen mukaan. Taman
jalkeen luodaan yksinkertainen valaistus
valitsemalla Create -> Lights -> Standard
-> Skylight ja klikaamalla mihin tahansa
kohtaan Scened. Avataan Render

Scene painamalla 'F10" ndppadimistosta
ja siirrytdan Advance Lightning-
vdlilehdelle, jossa valitaan pudotus
valikosta Light Tracer. Nyt kaiken pitaisi
olla renderdintia varten valmista.

13



3.1 Textuurit UVYWmap (liikennemerkki) helppo

e 2le@mT| 1.Luodaan sylinteri, [ S 01 bt =B 5 Avataan Material
ol o~ ) - - . . .
5 Create-> Geometry -> Editor ylavalikosta,
=== Stadard Primitives-> Rendering ->
I AubsGrid . .

s | Cylinder ja asetetaan Material Editor tai
(GeneiTe sille kuvan osoittamat painetaan kirjainta ‘M’
= arvot. nappaimistésta. Esiin

T —) arPe -
|—r\ Pa% % x @i (%o @ (Fe s pitdisi avautua erillis
[ Creatonbethod | %, [0 -Defaul - andar .
e = fe == paneelin. Rullataan
e Cuiesn s o | palleroiden alapuolella
T3 e e olevaa valikkoa alaspain
Height:[1.0 E I Specular Level . [T00 4 Hone:
e - o —— kunnes tullaan Maps-
CapSegments [T I~ Sefilurination [T00 2| Hone . K
e [T o L —— alavalikon kohtaan, joka
IV Smacth [~ Fiter Color .. [T00_ 3/ Hore. X ’
I senon DA e——— avataan klikkaamalla.
T Refiactinn T el

o el 3. Etsi esimerkiksi Googlesta \v’;v‘
b A mus: mmmm mmmm [ Sopiva liikennemerkin
kuva, joka on otettu
mahdollisimman suoraan
edesta ja merkki on
mielellaan keskella (muista
mikali julkaiset toitasi pitaa
myos tekstuureihin olla
oikeudet). Tallenna kuva ja

rengaspg rongas.mx sandbosipa

P50l @ T & &
5] Standard

I~ Ambient Color -~
Do S " s : = avaa Oma Tietokone. TAman
FsaaaT ; : \, , " jalkeen raahaa kuva nuolen

I~ Selfllluriation

[ 2|

mukaisesti Diffuse Colorin

I Opacity [0 2 None
T —— vieressa olevan nappulan
e — paalle. Taman jalkeen tarraa
L — hii e .

- [ iirella kiinni pallerosta ja

= IHHIHHX\FIHHHHZEDHHH\HHH\HHI‘\HHl\H\Jp\\H\H\\E\pll\\HHUHIHHHHHHHHHHHHH\D raahaa Se tekeméSi Sylinterin
[otwasse 8 i e ﬂl “wle padlle. Voit jo render6ida, mikali haluat. Mutta
|| Cick and diag to rotete the view, Clicking i the tabs constrains the rote] * ‘AddTw e Tag Setkey| S, Keyfiters. | [0 e e v veee Jeel e . .
tekeleen tulisi vield ndyttaa lahinna omituiselta

varikirjolta.

\\\f|A\[®\@|T\ | @] A @| 3| T|

—GD ,H 4. Korjataksemme tilanteen valitse sylinteri ja lisd
T = | - sille UVYW Map seuraavasti Modify -> Modifier List ->
reactor SoftBody . . . . . .
e UVW Map. Valitse valikosta Cylindrical ja raksi Cap-
Ee kohta. Oranssien viivojen tulisi kehystaa sylinteri sen
T =l “2'®  reunoja pitkin, mikali kehykset eivat tunnu olevan
E‘h R N laheskaan kohdillaan voi rullata alemmas valikossa
Fcen & i o klikata painiketta Fit. Kokeile renderdida merkki.
Subdivide  Spheical - . . .
S © s Lopputuloksen‘tulls!.olIa jo paljon parempi, mutta
o) I edelleen reunoilla nakyy valokuvan alueita, jotka
TuboSmeath - . ..
e s eivat kuulu merkkiin.
Tk Height[Tom— 2|

i |
Dwisam Wi [TT— 21 Fip
o || [T Reskword Man Size

| 5. Suurenna UVW Mapin Lenght ja

w [l e . . . .
Width -arvoja kuvan mukaisesti,
e niin etta ei halutut alueet kuvasta
A eivat enaa mahdu sylinteriin vaan
o jaavat sen ulkopuolelle. Merkki ei
© Face N . oo . . .
¢ sz unr kuitenkaan todennéakdiseti ole viela
keskella sylinteria
Height [TA0T 2|
UTie[TT ™ Fip
VTe[TT 2 Fip
WD 5l Fin




w|e A @@ T
T
Maodifie

9@ VW Mapping
e Gizma

Cylinder

6. Klikka UVW Mapping
alavalikko auki "+" merkista
Modifier Listin alapuolelta ja
klikkaa Gizmo valituksi. Nyt

Al w8 lm A TR s
—— voit liikutella rajausaluetta
Parsmelers .
= vapaasti. Alueen mukana
somm e || myos tekstuuri liikkuu. Joten
e yritd saada liilkennemerkin
€ Face . . .
© xu tekstuuri keskelle sylinteria
Length[850 2| 9 . .. .
T g kokeilu ja renderdinti
Height[TO0T 2] .
im— - | PEriaatteella.
VTie[TT 2| Fip
WTelTT s Fin

% %X | |4 % o &[T & &

%, |01 - Defaul ~|  Standard

[- Maps |
Apnoink M ap

I Ambisnt Color . Iﬁi! Hatie |
¥ Diffugs Color. . JT00° 2] (492 [TrafficSigmm14_M_ipg]||§
[ Specular Color . [700 ii MNaone |
™ Specular Level - I'I_Dﬂ_ﬂ MNone |
™ Glossiness ... .. 00 % Mone | 7. Avaa uudelleen Material Editor ja Oma Tietokone. Raahaa talla
I~ Seltllumination . [T00° None | kertaa liikennemerkin kuva esimerkin osoittamaan paikkaan
[~ Opacity . ..o00 [0 £ Mane | Bump -sarakkeelle. Merkissa olevista naarmuista tulisi nyt tulla
I™ FiterColar ... [T00° 2 Mone | ikaan kuin syvempia ja osa kuviosta on ikdankuin kohollaa.
M Bump ... [30 3| @53 (TrafficSigns0i14_Mipa) | Bump toimii siten, ettd tummiin kohtiin tulee ikddn kuin kuoppa
I PReflection ... . [To0” 2| Hane | ja vaaleisiin kohtiin kohouma. Bump tekstuurin ei tarvitse olla
I~ Refractior, .....[100 2| Mone | sama kuin mité kaytettiin Diffuse Color kohdassa vaan se voi olla
I Displacement .. [T00° 2| Mane | esimerkiksi television kohinaa jaljitteleva kuva jolloin koko kyltista
i e [ 100 1 Mane | pitdisi tulla ropolidinen/epatasainen.
I e g e s 1DD£} I@re |

. ; i 7. Lopuksi kopioidaan sama lilkkennemerkin kuva myos
P22 %X (@4 (%o @[T [ P OP ; va myos
isplacement -sarakkeelle ja annetaan arvoksi 5. Tall6in
%, |01 - Defaul v|  Standard likennemerkki ruttaantuu hivenen. Displacement ei kuitenkaan
|

T= Maps ole tarkoitettu liikennemerkkien ruttaamiseen vaikka toimiikin
el Map siiné varsin hyvir?. .
I Ambient Color . . Iﬁi! Mitie: | Dlspla-‘cemc?:nt toimil h!venen
¥ Diffuse Colar .. JT00° 2| #92 [TrafficSigns0114 M_ipg]||E el k?m B“”?p' el
= = tummat savyt painavat
I Specular Calor  [100 2| i | taaksepain ja vaaleat savyt
I Specular Level . [100 <] Lol | kohottavat. Displacement
I Glassiness ... 100 & | S | kohottaa ja laskee kuitenkin
[ Seltilumination. [T00° +| Nane | renderditdessd vertexien
I™ Dpacity ..o fioa < MNaone | avulla. Mita enemman
I~ Filter Calor ... [T00 3] Mane | vertexeja objektissa on
W Bump ........JT32° | #93 [TrafficSigns0114 M.ipg) | sitd useammasta kohtaa
I Reflection ... .. | = More | Displacement map pystyy
I Refraction .. ... I'I_Ifﬂ Mone | niitd lilkuttelemaan.
¥ Displacement .. [§ 3| #34 [TrafficSigns0114_M.jng) |
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3.2 Textuurit Unwrap (Auto) keskivaikea

[

Smonth + Highlights + Edged Fi

[ Smionth + Highlights + Edged

B edit uvws

File Edit Select Tools Mapping Options Display View

[ o [recmraten (chesery ~

BRI || &/ ©|E) 2|

" sl 1. Muodosta kuvan
“‘"’"Wj arvojen mukainen
Height: [30,0 — N
laatikko.
Length Segs: [1 =
Width Segs: [T E )
Height Segs: [T E %::*I@Eh|"@|}‘
@ B B Ionotn .
I~ RealWorld Map Size I @
Subdivide (WSM) -~
Surface Mapper (WSM)
SurfDeform (WSM)
OBJECT-SPACE MODIFIERS
Affect Region
Attribute Holder
Bend ]
Camera Map
. CapHoles
N . . . . . . . . . [ Clom
2. Pida laatikko valittuna ja valitse Modify -> Modifier List -> Edit Poly. I—
DeletePatch
Disp Approx =
Displace
Edit Mesh
Edit Mormals
Edit Patch
SEE e 3. Valitse Vertex -valitsin
" CILT | ja muokkaa laatikko
E EEn Il suurin piirtein kuvan
me . .
@ 9 mukaiseksi.
| -Vertex ctio
I~ By Vertex —*_' E|ﬁ%|‘|@‘;“
[ Ignore Backfacing IBoxUUl .
I~ By Angle: |450— ﬂ
shick | eow | I t
Ring ﬂ Loop ﬂ Relax -
Get Stack Selection | TEE
Select By Channel
Shell
_ " . . . ke
R s 4.Vaihda Polygon -valitsimeen ja i
e klikkaa aktiiviseksi keskimméinen S
I e )| yldpinnan polygoneista. Rullaa Edit iﬁ:ﬁiipm
Il Poly valikossa alaspdin ja etsi Extrude- Sice
nappula. Klikkaa nappi aktiiviseksi S
. . . . Spherify
pal‘na huren vasen.nf'.applupohjaa'r.l ) cauecse
= valitun pinnan paalla ja liikuta hiirta ST Check
moeFoneice  |B || ylGspadin. Kunnes saat palikasta kuvaa :"b:“d
erlg&*le ] ubdivide
—IE J vastaavan. Substitute
SurfDeform
5. Pida autoa muistuttava palikka valittuna ja Symmetry
klikkaa Modifier List auki uudelleen. Valitse :zum
tallakertaa Unwrap UVW. Turbosmaoth
Turn to Mesh
Turn to Patch e
Turn to Poly
.. - .lr eSS Twist

EXeE

vz wps

U I [[aes - OREEE

o001

B 6. Rullaa avautunutta

“ valikkoa alaspain kunnes |6ydat Parameters -valikosta
Edit -nappulan, jota klikkaamalla erillisen Edit

UVWs -ikkunan tulisi avautua. Taman jalkeen avaa
Unwrap UWYV -alitasot klikkaamalla kohdalla olevaa
+ nappainta Modifier List:in alla. Valitse alitasoista
Face. Taman jalkeen valitse kaikki auton toisen sivun
pinnat Ctrl pohjassa. Taman jalkeen rullaa valikko
kohtaan Map Parameters. Valitse Y ja klikkaa Quick
Planar Map -painiketta. Auton kyljen tulisi muuttua
oikean muotoiseksi Edit UVWs -nakymassa. Siirra
vielda kuvan mukaisesti valittu pala sivuun.

Modier Lt

@?
Vet




[V Preview Quick Map Gizmo

ﬁ‘) . -

¢~ Averaged Normals

= |

¥ Al @ E 2
O @[d o 88 %

|standard -

= Object Type ]
™ AutoGrd

Target Spot ‘ Free Spot ‘

Target Direct ‘ Free Direct ‘

= Name and Color |

Sky0O1
= Skylight Parameters |

¥ On m'ﬁe:lm—g

skyColor——————————

¢ Use Scene Environment

& Sky Color ... [ ]
[ Map: 00,0 2]

[~ Cast Shadows

RﬂwwW:lzo—j
Ravl!m:'o,oTj

10. Valitaan auto, mikali objekti ei ole edelleen
valittuna ja avataan uusi ikkuna seuraavasti.Rendering
-> Render To Texture. Taman jdlkeen valitaan haluttu
kohdekansio kohdasta Path. Tarkistetaan, etta

Render Setting -kohta on kuvan mukainen. Rullataan
alaspain kohtaan Output ja klikataan Add -nappulaa,
tdman jalkeen valitaan ponnahdusikkunasta Diffuce
Map, annetaan tiedostolle haluttu nimi ja valitaan
pudotusvalikosta Diffuse Color. Lopuksi klikataan vield
512x512(tekstuurin koko, halutessaan voi kokeilla

eri kokoja) nappulaa ja Render. Nyt renderginti
ikkunan tulisi avautua, ja siihen tulisi renderoitya
tekstuuri koordinaatiston, joka tallennetaan kuvaksi
klikkaamalla vasemman ylakulman Diskettia.

Kuva voidaan taman jalkeen avata kuvan kasittely
ohjelmassa. Ja siihen voidaan maalata ja piirtaa
haluttuja asioita. Taman jalkeen kuva voidaan asettaa
objektille tekstuuriksi ja piirros asettuu malliin
koordinaatiston mukaisesti.

| 7.Toista taman jalkeen sama toiselle
kyljelle ja taman jalkeen valitse Ctrl
pohjassa ylospdin suuntautuvat
pinnat. Vaihda valinta kohtaan Z ja
klikkaa Quick Planar Map -painiketta.
| siirra syntynyt kokonaisuus jalleen

| sivummalle.

8. Toistetaan sama viela

"auton etulasi” ja "nokka”
pinnoille, kuten vasemman sl et .
puoleisessa kuvassa ja 1 o e
vaihdetaan valinta kohtaan
X. Seka taman jalkeen
pohjalle vaihtamalla valinta
kohtaan Z. Lopuksi kaikki
palat skaalataan sopivan
kokoisiksi ja sommitellaaan
takaisin nelion sisaan jota
reunustavat tumman siniset
viivat (Oikeanpuoleinen
kuva).

9. Voit sulkea Edit UVWs-

. Render To T = > )
ikkunan. Luodaan autolle ELrcam he e —
. . = ral Setti
valaistus valitsemalla v S— ‘
Create -> Lights -> IP_“' RS =N N
. Skip Existing Files W Rendered Frame Window
Standard -> Skyllght. Ja v
luodaan valonlédhde auton setip.. |
ylapuolelle. [ NenerkRee
E Objects to Bake ]
Object and Output Settings
I ’7 Presel:I -
L Object Sub-Object Edge
Il Name Channel  Channel Padding
| Mame Obje... Sub-O.. Eda...
Box001 1 2

Selected Object Settings
’7l~7 Enabled Padding: [2~ 3] ‘

¥ | Object Leve! |¥ | 5ub-Object Levels
& Put to Baked Material ¢ Put to Baked Material
& Full Size £ Proportional

[~Mapping Coordin

[~ Projection Mapping
I” Enabled |(Mo Projection Modifie w  Pick... | Options...

Object: @ Use Existing Channel .
 Use AutomaticUnwrap  Camnei |1 T

Bub-Objects: ¢ Use Existing Channe! =
B U srniie e et £

Clear L |

¢ Individual # plSelected ¢ All Prepared

C S |
[l Perspective, frame 0, RGBA Calor 16 Bits/Channel (1:1) | = & 3¢ e lizme, Soment Mo S Lo
= = BoxD01DiffuseM... DiffuseMap 5124512 Diffi
(BB xuEX [e]ejece | [reasiona
< | ] | 3
| _ose |
Selected Element Common Settings ————————————————
¥ Enable  Name: DiffuseMap
File Name and Type:  Box00 IDiffuseMap. tga =l

Target Map Siot:
Element Type: diffussMap
glement Background: [
™ Use Automatic Map Size
Width: [512 3| | 128x128 1024x1024
Height: [ST2 3| (@) 256x256 | _766x768 | 2046%2048
~Selected Blement Unique Settings.
I Lighting
I™ shadows

Views Render

Lhwlapﬂ'ly Coce | ongnas 0" e

.
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4. Animointi/Bones (Ropotti) helppo

1. Luodaan laatikoilla ja sylintereilld suurin piirtein kuvan
osoittaman tapainen kapistus, jossa on runko, nelja pyoraa
ja paa (punainen laatikko).

] e Tl | algeZ 2|
O G7 &F e o0

[standard -

2.Taman jalkeen aletaan luoda boneja Create -> Systems -> Bones. Boneja luodaan klikkaamalla ensin luun Iahtokohta
hiiren vasemmalla ja sen jalkeen paatos kohta hiiren vasemmalla, tdman jalkeen ohjelma yrittda luoda peraan uuden luun,
mutta klikataankin hiiren oikealla, jolloin luun perdaan syntyy tynka luu, joka poistetaan nappadimiston Delete- painikkeella.
Lopuksi asetellaan luut kuvan mukaisesti. Renkaiden sisalla olevien luiden tulisi asettua renkaan keskioon.

R

Create | Modifiers Animation Graph Editors Rendering
Standard Primiti v ok . o .
S e & D= 3 | yodaan kaksi Dummya klikkailemalla Create -> Helpers -> Dummy. Tehdaan
AEC Objects v et (&35 g2 dummyistd alemman kuvan kokoisia ja asetellaan ne kuvan mukaisesti
Compound 8 | 1+ 1 Fromfviretrame | renkaiden sisalld olevien bonejen viliin niin ettd ne ovat keskella rengasta
e ' sivulta katsottuna. Lopuksi nimetdan luut ja dummyt kuvan mukaisesti.
NURBS L4
Dynamics L4
mental ray L4
Shapes »
Extended Shapes 4
Lights 4
Cameras 4
>
SpaceWarps L4 Expose Transform
Systems L4 Grid

Point
Container

Tape Measure
Protractor
Compass

Camera Point

Delegate
Crowd

RRRRARAARARRARSARRRNRAN
IR R R
& [

Atmospherics +

Manipulators 3
Particle Flow 3 ne + Edoged
e i ™ |

L O

[[Runkoe -
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ﬂs:hemmicview

Edit Select ListViews Layout Options Display View

o & ax|BgiEl2==2=s|=]5 2 | = [t 4. Avataan Schematic View klikkaamalla

i FHH FEEEH EEEEE PR FEEEH EEEE oikean ylakulman laatikosta. Naytt6on avautuu [~
ponnahdusikkuna, jossa jarjesta nimetyt laatikot kuvan

mukaisesti. Taman jalkeen klikkaa Connect aktiiviseksi

ja lahde yhdistamaan palikoita alhaalta ylospain.

: Yhdistadksesi laatikot paina ensin hiiren vasen painike

ERRHRRE pohjaan laatikon paalld, siirra hiiren kursori ylemman

BEAH i ﬁ " laatikon paalle ja vapauta painike. ﬂ' =

HHHHHH HHHHHH 5 T I O S S Y1 DS Bt 0 15 5 ) ) 1 I

PathDeform

Physique

Point Cache 5.Taman jalkeen klikkaa vasen takarengas aktiiviseksi ja

R —| valitse Modify -> Modifier List -> Skin.

Preserve

Projection

ProQptimizer

Push =

Quadify Mesh

reactor Cloth

reactor SoftBody

Relax T

Ripple

Select By Channel

Shell

Skew

Skin Morph

Skin Wrap

Skin Wrap Patch -
6. Rullaa skin valikossa alaspain kunnes Select Bones e Oy ————]
I6ydat kohdan Bones: Add. Klikkaa T WWW“@‘ 2
nappulaa ja Select Bones valikon tulisi R REGR & HCIEOE ‘ = F. [erincerocz ]
avautua. Nyt valitse Vasen taka luu ja Select.  Ffina: | selection Set: & e M

Name |
.. s ese . . . . Runko Cylinder
Taman jalkeen valitse kyseinen luu jossakin [ e sisia
neljasta nakymasta ja kokeile pyorittaa > Oikea Etu
s rae) ) S oo [ vesen ety
sitd. Mikali kaikki meni oikein renkaan tulisi |2 aca sisiis
L - o ———
renkaille, seka yhdista paan laatikko paa > s
luuhun ja rungon laatikot runko luuhun. L Baifes tul e
¥ Envelopes
¥ Cross Sections

Lopuksi sinun tulisi pystya liikuttamaan - —
koko objekti roykkiota, liikuttamalla —
pelkkaa runko luuta. ‘

7. Kun edellinen vaihe on valmis. Klikkaa alareunan
Auto painike pohjaan. Siirra valittu Key frame kohtaan
100 ja siirrd rungon luuta eteen pdin. Taman jalkeen
valitse vuoron peradn akseli-dummyt ja pyorittele
niitd renkaiden suuntaisesti. Vapauta Auto -painike ja
klikkaa oikeassa alakulmassa olevaa Play Animation-
painiketta. Koko harvelin tulisi nyt liikkua ja renkeiden
pyoria eteenpadin.

e 5]
‘EIIII|IIII|IIII|IIII|IIII|IIII|IIII|IIII|IIII|IIII|IIII|IIII|IIII|IIII|IIII|IIII|IIII|IIII|IIII
9 10 15 20 25 30 35 40 45 50 55 60 65 n 75 80 85 a0 35

| 1Helper selected & B w0 lvf42,5 2lz:fo,0 2] crid = 10,0 oy (At |ﬁected .

coms T ||| glick and drag to select and rotate objects | | Add Time Tag SetK. | ™\ Fiters...
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